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Spell Checker Setup

To configure the spell checker in Group Mail simply click on the Setup Menu on the 
Main Screen and then click on the Spell Checker Setup menu item.

When you install Group Mail it installs the default US English dictionary. To use this 
dictionary you can leave the 'Select the dictionary you wish to use:' field blank. Aureate 
Group Mail will know that you want to use the default one then. 

Several other language dictionaries are available for use. These can be Downloaded 
from the Group Mail Website.

To install and use these other dictionaries please refer to the readme files that are 
included with each of them.

Group Mail can also use the same custom dictionaries that are used in MS Word and 
other common word processors. To select a Custom Dictionary click on the Select 
button opposite the 'Select a Custom Dictionary to use' field.

To use the Spell Check press F9 or just click on the Tools Menu and then on the Spell 
Check Item. It is also available from the Toolbar.

Return to the Main Index
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Email Setup and Configuration

To Configure your Email settings please click on the Setup Menu on the Main Group 
Mail screen followed by the Email Setup menu item.

You can select which send mode to use from the Send Modes drop down list box.

In Group Mail Free there is only one send mode available to use and that is Standard - 
Send through an SMTP Mail Server. In Group Mail Pro there are two send mdoes 
available - Standard and Direct. In Group Mail Plus all Send Modes are available.

Send Modes Explained: 

Standard - Send through an SMTP Mail Server. All messages sent in this mode will be 
sent to your SMTP Mail Server (as specified) for delivery to your recipients.

If you select to send your messages this way then you must specify the address of the 
SMTP Mail server that you wish to send messages through. If in doubt you should 
contact your Internet Service provider or Network Administrator or try checking how your 
existing Email Software is configured for sending email. The port setting should be 
equal to 25 unless you are otherwise informed. (25 is the standard TCP/IP port for 
sending Email through.)

Some SMTP Mail servers require you to logon on to your email account before they will 



accept email from you. There are two main ways of doing this (if you do not know which 
applies to you then you should consult the mail service provider for more information)

· Requires SMTP Authentication
Check this option if your Mail Service Provider requires this. Click 
Setup beside this option to specify your account details. Please note 
that Group Mail provides support for both common forms of SMTP 
Authentication - AUTH-LOGIN and CRAM-MD5. Unless you have been 
told otherwise you should use just AUTH-LOGIN. Also, if your mail 
provider doesn't require you to use SMTP Authentication and you have 
it enabled you will receive an Error Message when you attempt to send 
your messages.

· Requires POP3 Authentication.
Some Mail Service Providers require you to check your email account 
before you send your messages. Group Mail can do this automatically 
for you - just select this option and then click Setup beside it. You will 
need to know the address of your POP3 Email Server (contact your 
provider if in doubt or check your existing email software for details). 
Also, Eudora users! - please only enter your username in the 
username field. This is typically the first part of your email address or 
your entire email address - not a mixture of email address and mail 
server address. 

When Group Mail checks your account for you it will only ever login 
and then log off. It will never actually download any messages for you 
when doing this.

Passwords for both of these options are stored in the FB.dat file in the Group 
Mail folder. Please note that they are encrypted to keep them private.

Timeout - this setting determines how long the software should wait for a response from 
the SMTP Server. If you are on a slow connection or if you know the SMTP server that 
you are using to be slow then you should set a suitable time period here. Typcially 30 
seconds to 1 minute is more than adequate.

Reconnect Settings - some mail servers are only capable of accepting a certain amount 
of messages from any one sender per connection. Group Mail is able to cope with this 
by automatically reconnecting on the fy while deliverying your messages. This avoids 
over loading/killing your mail server.

Pause Settings - some ISPs have strict limits on how many messages a user can send 
through their mail server - this setting allows you to work with these limits and avoid 
breaking the rules. The pause setting works in conjunction with the Reconnect setting.



Direct    - Send Messages Directly to Recipients - No SMTP Server Required.

Using this option allows you to completely bypass the requirement for a mail server. 
Group Mail will deliver each message directly to your recipients email accounts. For this 
to work properly you need to specify a valid DNS server. Please note that this option is 
only available in the Pro and Plus versions of Group Mail.

DNS Server: If you choose to send your messages directly to your recipients (and thus 
bypassing your local mail server) you will need to specify a Domain Name Service 
Server address for Group Mail to use when determining how to contact each recipient. 
99% of the time the software can automatically determine what the address of this 
server is. If it appears blank to you then it is recommended that you go online and then 
click on the Query System button. If this also fails to yeild a result then you will need to 
contact your ISP or Network Admin for the address of the DNS Server that you should 
be using.

Timeout: This determines the amount of time Group Mail will wait for a reply from your 
mail server (and DNS Server if sending direct). If your connection is particularily slow 
then you should set this to the maximum ten minutes. Otherwise one minute thirty 
seconds is usually more than enough.

Retry on Failure Setting: If while direct sending an error is raised (either by the MX 
Lookup or while trying to talk with the recipients mail server) then the software can retry 
the whole process up to 10 times. Typically problems are intermittant here and can be 
caused by a number of issues including slow connections, invalid DNS details, slow 



servers etc.

Route through SMTP Mail Server on Failure setting: If Group Mail is unable to deliver 
directly then you can configure it to automatically try to deliver such messages through 
your SMTP Server (You need to configure Standard Send mode above in order for this 
to work correctly).

Express - High speed sending

Using this option allows you to use the SMTP Express high speed message sending 
system (allows up to 64 messages to be sent at the same time - this means incredible 
sending speed is assured). With this option you can select to route your email through 
an existing email server - or send directly to your recipients - thus completely bypassing 
the requirement for a mail server. There are some settings which can be altered for 
SMTP Express - to gain access to them just click the Setup button beside this option. 
See the SMTP Express Help file for more details (available from the SMTP Express 
Setup screen). Please note that this option is only available in the Plus version of Group 
Mail. It is recommended that you review the additional documentation that comes with 
Group Mail Plus regarding SMTP Express. This documentation can be accessed from 
the Extra Information Tab.



Test Settings:

Button located on the left hand side at the bottom of the Email Setup and Configuration 
Screen. Click on this to test your current settings. This can be a very quick way of 
checking that your settings are correct and working properly.

It is recommended that each time you make changes to your setup that you test them. 
Also we recommend that you try a couple of different email addresses when testing and 
that you wait for each of them to be delivered so that you know your settings are indeed 
correct.

Once you are happy that all settings are correctly please click OK. All new settings will 
be applied then. If you do not wish to record your latest changes then click Cancel and 
all will be forgotten.

Return to the Main Index
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Group Mail - Getting Started

Configure your Email Settings
The first thing that you should do when you start Group Mail is enter your email settings. 
You will only need to do this once. The main details you require are your 'From Email 
address' and your 'SMTP Mail Server' address (if in doubt about this ask your ISP). If 
you are using the Pro version you can of course avoid using an SMTP Server and just 
send direct. For this to work properly though you will need to know the address of your 
Domain Name Server (DNS), again contact your ISP if in doubt. 

To enter this information either fillout the Welcome Wizard or from the Main Screen click 
on the Setup Menu followed by Email Setup then go to Identification Setup to enter your 
email address etc..

More Information

Create a Group and Add some Recipients
Now It's time to setup some Recipient Groups. To do this click on the Group Manager 
Tab on the Main Screen. To create a Group just click the New button in the Group 
Section. Give it a name and click OK. That's your first group created and ready for 
recipients.

More Information on Create Groups

Once you have setup a Group you can add Recipients. Select the Group you wish to 
add to first and then click the Add Recipient button.

More Information on Adding Recipients

If you have Recipients stored in another file these can also be imported. To import them 
just click on the Tools menu (on the Main Screen) and then on Import.

More Information on Importing Recipients

Prepare a Message and Send it
Now It's time to do the fun stuff. To create a message just click on the Edit Message tab 
on the Main Screen.

More Information on Editing Messages
More Information on creating highly formatted HTML or Rich Media Messages
More Information on Attaching Files



Once you have created your message you are now ready to send it out. To do this click 
on the Send button on the bottom of the Edit Message Tab (or press F5 or click the 
zoom envelop on the Toolbar).

Return to the Main Index
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Creating, Modifying and Deleting Groups

What is a Group?
A Group is essentially a list of Recipients. Within Group Mail you can setup/create 
32,000 different Groups.

Creating a Group:
To create a Group just click on the New button in the Groups section on the Group 
Manager Tab. The first and most important thing you should do then is give the Group a 
name. This name must be unique and should be composed of standard Alpha Numberic 
characters only.

If you like you can then specify custom Identification details for the Group, such as what 
Name and Email address to apply to the message header when you are sending 
messages to that group (as opposed to those you specified in Email Setup). This can be 
an incredibly useful feature if you run both business and personal mailing lists. 

To enter Custom (different) Identification details make sure that you select and check 
the 'Use different Identification details for this Group' check box. If you then clear this 
check box any custom details you specified will not be applied to future mailings.

Modifying a Group:
Modifying a Group is essentially the same as creating one. To do so just click the Modify 
button in the Groups section on the Group Manager Tab.

Deleting a Group:
To delete a Group you should click on the Delete button in the Groups section on the 



Group Manager Tab. You will then be prompted to confirm the deletion. All deleted 
groups will be placed in your system Recycle Bin. If you restore a group from their at a 
later stage you should restart Group Mail if it is already running.

Return to the Main Index
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Adding, Browsing, Modifying and Removing Recipients

Adding Recipients
Once you have Created a Group you can proceed with adding Recipients.

To Add a Recipient to a Group you must first select the Group on the Group Manager 
Tab. Then click on the Add Recipient button found at the bottom of the Groups list. This 
will bring up the Add Recipient dialog. The only mandatory fields that you must fill in on 
this screen is the Email Address. The other fields are not required but may come in 
useful if you wish to Send Personalized Messages later.

Please note that you cannot add Duplicate Email Addresses to a Group.

Browsing Recipients
To browse/view a group you need to select it on the Group Manager Tab., then click on 
the Browse or View Recipients button. You will then be presented with a screen like the 
following one:



 

Please note that it is possible to change what fields are shown on this screen - just click 
on the View Setup button on the bottom right hand side.

Modifying a Recipient
To Modify a Recipient you must first be browsing or viewing the target group. Locate 
and select the Recipient then click on the Modify button. A similar screen to the Add 
Recipient dialog will be presented. You can change any details on this screen including 
the Email Address.



Deleting a Recipient
To Delete a Recipient follow the same initial steps as you would for Modifying except 
click on the Delete button. Please note that once you confirm the deletion there is no 
Undo capability - Deletion is final. 

If you do not wish to delete the selected recipient(s) you can choose to Exclude them. 
Deletions and Exclusions can be applied to all groups as well.

Return to the Main Index
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Copying and Moving Recipients

Simply select the Recipients that you wish to copy/move on the Browse or Search 
Screen and click on either the Copy or Move button.

Once you have selected the Recipients that you would like to Copy or Move you need to 
select the group that you would like to Copy/Move them to (See 'To This Group section 
on the Move/Copy screen'). You can deselect somebody by clearing the check box 
opposite their details.

While you're Copying/Moving Recipients you will be prompted if an existing instance of 
a recipient exists in the destination group. To avoid being prompted for action you can 
select that all existing matches be overwritten with the new information. To do this check 
the 'Overwrite Matching Recipient Details in this Group' option (See 'To This Group 
section on the Move/Copy screen') .

Please note that if you select to Move the Recipients they will be deleted from the 
host group.

Return to the Main Index
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Searching Groups for Recipients

To Search a Group for Recipients just click on the Search button towards the bottom of 
the Recipients section on the Group Manager Tab (Please note that you must have a 
group selected before you can do a search).

Select a Group to Search
Means exactly what it says. Using this Dropdown you can select any groups you have 
created in Group Mail. The last item of the group allows you to select all groups.

Specify Search Criteria
In this section you can specify how you wish to search for a Recipient. The first 
Dropdown list contains all the Fields that you can base your search on. Select which 
ever one is appropriate. The second Dropdown contains options which relate to the way 
that the chosen field will be searched. Finally you should specify the data you wish to 
use in the Search in the edit area.

If you wanted to search for all email addresses that ended with '.com' you would select 
the following:

Dropdown list 1: Email Address
Dropdown list 2: Ends With
Edit Area: .com

Then just click the Search Now button.



Results
This section lists the Recipients that matched your Search Criteria.

· Select All
Click this button to select all the recipients in the result list. This can be helpful if you wish to 
Copy, Move or Delete all the Recipients found.

· Copy / Move
Copy or Move any selected Recipients to another Group.

· Modify / Delete
Using these buttons you can Modify or Remove any of the Recipients in the Search Results list.

· Export
Save the Search Results to a file. Click here for more information regarding Exporting.

Return to the Main Index
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Importing and Exporting Recipients

To Import or Export a Group click on the Tools Menu on the Main screen or see the 
Groups Section on the Group Manager Tab.

Importing to a Group:

Input Selection:

The first stage of the wizard lets you choose where the data should be imported 
from. If It's from a file click on the Select button and locate the file that way. 
Otherwise, if the data is on the clipboard you should enabled the 'Import recipient 
data from the Windows clipboard option', please note however that the data must 
have been copied to the clipboard as ordinary text and it must be on the 
clipboard before you click the Next Button.

Press Next to move on

Import Options:

Once you have selected the data that you wish to import Group Mail will try and 
select the best options for importing it. You will need to double check that it has 
indeed selected the correct options. 

 
If you are happy that the correct options have been selected (such as delimiter, 
field count and name setup) then you can click next.

If you do not know how the data is formatted then you can select the Other File / 
Data formats option. Please note however that the Importer will only extract the 
Email Addresses if you enable this option.

Please note that there is also an option on this screen which allows you to turn 
off Duplicate Checking. You should only enable this option if you know that your 
Source Data is indeed unique. It is recommended that you do not use this option.

Press the next button to proceed

Import Field Match Up: (This only appears if you have selected the Delimited Import 
option).



The importer will try to locate the email address field and select it for you. All 
other fields will have sample data attached to them. Just click the Drop Down 
arrows that appear beside each field. The complete list is scrollable and so is the 
entire Field Setup display. 

If you do not wish to import certain information then just select the (blank) option 
for that particular field.

*** TIP: To aid importing you might consider adding the field names to your data 
file before importing. You would add these on the first row of the data that you 
wish to import - then at this stage in the import process each field name will show 
as the sample data for each field. 

Click Next to Proceed or use the Previous button to make changes to the way 
that Group Mail should expect the file to be layed out.

Import Filters:

You can setup Filters which determine what data is imported. Use the Add button 
to create a new Filter or use Modify to change an existing one. You can save a 
list of common filters and then reopen it again when you need by using the Open 
and Save buttons.

Remember that you can create as many filters as you wish.

It is important that you note the order of your Filters. If you wish to Remove all 
addresses that end with .com and then you wish to only accept addresses that 
have each field filled out correctly you should make sure that the .com filter is 
first. This can save a considerable amount of time when you are Importing.

Exporting a Group:

To Export a group all you have to do is Select the Group you wish to Export, then 
select the file that you would like to export the Recipient information to. You can 
then decide how you wish to delimited the data which your Exporting and wether 
or not you want to include the Field names.

In the 'Which Group Fields do you want to Export' Section you can decide what 
order and which fields to export. Use the updown arrow to determine the order 
and check which fields you'd like to include in the Export. You can also sort the 
data on any field you like before Exporting it.

In the 'Select which Recipients you wish to Filter' section you can determine 
which recipients you wish to Export. For help on creating Filters see above 
(Import Filters).



Return to the Main Index
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Excluding and Blocking Recipients

Open the Exclusion list by clicking on the Tools menu followed by the Exclusion List 
item on the Main Screen.

Any recipients on this list will not receive messages which are sent to the specified 
Group you have chosen to Exclude them from. When you do a mailing you can see 
each recipient that is blocked in the Exclusion Log.

Use the Add button to add new recipients manually to the list.

To Import and Export to and from the list see here.

If you wish to block recipients temporarily you can use the Advanced Exclusion option 
on the prepare to send screen or by creating send filters. Click here for more 
information on using these techniques.

Return to the Main Index
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Importing and Exporting the Exclusion List

To Import or Export the Exclusion list you need to activate the Exclusion List Utility. Do 
this by clicking on the Tools menu followed by the Exclusion List item on the Main 
Screen.

Importing:
Importing to the Exclusion list is much simpler than Importing to a Group. For instance 
the import file can be any format. The only data that is imported is the Email Address.

You can also decide if the data you are Importing is only to be used to exclude 
recipients from one list or all lists. Just select which setting you prefer on the Group 
Drop down. Filters may also be used to determine which email addresses are imported. 
You can configure as may filters as you wish based on the Email Address Field only.

Exporting:

This is the very same as Exporting any other Group except that the only fields that you 
can export are the Email Address and the Group (that the recipient is excluded from).

Return to the Main Index
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Editing, Spell Checking and Printing Messages

Editing Messages:
To create a new message click on the File Menu followed by the New menu item (On 
the Main Screen). This will create a new blank message for you. Messages in Group 
Mail can be text only. Group Mail Doesn't support images or formatted text directly. If 
you wish to use formatted mesage please see the section on how to incorporate HTML 
Messages.

To save a message follow the same steps as you would for creating a new one except 
this time select the Save option. All information contained in the message including 
Attachments, HTML Message details etc. will be stored to a file of your choice which 
you can then open at a later stage.

To Print a message click on the Print menu item on the File menu.

Spell Checking:
To Spell check a message just click the F9 button on click on the Spell Check menu 
item under tools. To configure the spell check see the Spell checker options menu on 
the Main Setup menu.

Return to the Main Index
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Creating and Sending HTML / Rich Media Messages

If you wish to send a formatted (HTML) message then you need to prepare the 
message in a HTML Editor and save it to a file. To actually send it you must then select 
this file from the Insert / HTML Message file menu on the Main Screen or by entering 
the filename in the Optional HTML Message field also on the same screen just below 
the Main Edit Area.

If you have Internet Explorer 5 on your system you should consider using the new 
GroupHTML plugin which you can download from http://www.infacta.com

You can also send a standard text message along with the HTML Message. 

Special Considerations:

· In order to support older email client software (which don't support HTML 
Messages) you should also include a Text Message (a plain version of the HTML 
message without formatting would be recommended). Another way to deal with 
these people would be to send the HTML Message as a typical file attachment. 
They can then view the attached file in their web browser.

· The Message file can contain Merge fields just like the text message.

· If you are using images in your HTML message you should consider placing 
them on a web server and then link them into your message using their URL. 
This makes a significant change to your message size and helps speed up the 
email send process considerably. Also, you will not be sending unnecessary 
information to the people who are not using HTML Message compliant email 
software. If you do not elect to do this don't worry - Group Mail will encode them 
as inline images and include them with the message.

Return to the Main Index
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Merging Recipient Information

When you are editing a message you can also embed personal details for each 
recipient in your target Group. To do this click on the Merge menu on the Main Group 
Mail screen. Every field that is available when you are adding a recipient is also 
available on this menu. Just click the field menu item you would like to embed in the 
message and it will appear in the message in wrapped with the following characters: %* 
and *% - please do not edit these manually or they may not function correctly when it 
comes to sending. You can also embed personal information in the subject line. To do 
this click on the Subject area first (on the Main Screen) then click on the merge menu 
and select the field you would like to embed (it will appear in black only however).

If you include a HTML Message it can also host merge fields. However you have to 
enter them into your message manually. We suggest that you copy them from the Group 
Mail Message Edit area and paste them into your HTML Message.

Please note the following:

· If you enter a field in the message and the corresponding Recipient field in blank 
then nothing will show in that field when the message arrives with your Recipient.

In other words, If you embed the First Name field in the message but some of 
your recipients don't have First Name Information stored in their entries in the 
Target Group then nothing will show for each instance of that field name. e.g. "Hi 
%*FIRST NAME*%,"      for each recipient that doesn't have a First Name entered 
in the Target Group they will just receive "Hi," when they get their message from 
you.



You can stop people receiving messages if they don't have all the required fields 
filled out in the Group by setting up Send Filters.

· You cannot send in Bulk Mode if you use Merge Fields.

Return to the Main Index
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Managing Messages

Everytime you send a message successfully it will be stored on the Message history tab 
on the Main Screen.    You can open these messages again for editing and remailing 
simply by double clicking on them or by clicking the Open button.

Use the delete button to remove a message from the history list and place it in your 
recycle bin.

If you wish to delete all messages then simply close Group Mail down, then go to the 
Sent Messages Folder found under the Group Mail Folder and delete it.

Return to the Main Index
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Message Presentation Options

To configure how your messages are prepared before sending you need to click on 
the Message Setup menu which is on the Main Setup menu.

· Character Set
The full range of ISO 8859 Character sets (and some KO18 ones) are available 
for those who wish to send messages that contain extended characters. The 
default one to use is Western European / Americas ISO-8859-1. If you do not live 
in this region then you should choose the character set that suits your needs 
best. (they all have fairly descriptive names). 

· Message Encoding

If you are sure that your Email Message contains standard 7bit ASCII then 
you can select no (none) encoding here. Otherwise you should select 
either Printed Quotable or Base64 - both of these formats will ensure that 
your data is converted to 7bit ASCII which will allow safe transmission 
across the Internet.

  
It is important to note that if your message contains 8bit characters and you select 

no encoding - Group Mail will automatically encode the message as an 8bit ASCII 
Message. Some mail systems may refuse to accept such messages - or they 
may only accept some of it.

· Word Wrap
Use this option to specify how wide each line of text should appear in the 
recipients email reader. Most new email readers don’t require this option but 
older ones do. Please note than when a message is sent which has been 
wrapped it can look like a mess if the email readers window is too narrow. For 
best results you should set the wrapping option at 70 characters. 



It is recommened that you test/preview your messages if you are using Wrapping 
to make sure that they look OK. To do a test / preview send use teh Test send 
button on the Prepare to Send screen.

Identification Settings:

To configure how what details are sent with your message you will need to enter 
them on the Default User Identification Details screen which is available on the 
Main Setup menu.

· Name: Enter the name you wish to appear in header of the message being sent.

· Form Address and Reply To address: Enter the addresses you wish to appear in 
the From Field and Reply-to fields of your messages.

· Signature: Enter a brief message here that you want to be appended to each out 
going message.

Please note that each recipient group can have their own custom details. If you specify 
different details for a group these default ones will be ignored.

Return to the Main Index

Copyright © 2001 infacta ltd, All rights reserved - http://www.infacta.com



Sending Messages - Preparation

Once you have prepared your message It's time to Send it. Before you send it out to 
your Recipients though a host of options are available which will let you decide how the 
message is to be delivered and to whom. There is also a Test/Preview option which let's 
you see exactly what the recipient will receive.

General Tab:
Group Details:
This just reminds you of the group that you choose to mail to and It's size. You can 
select a different group here if you wish - please note however that any of the options 
you may have set on the prepare to send screen will be reset.

Sending Method:
You should choose the Personal Send option if you wish for each recipient to receive a 
message with their own email address in the 'To' field. Personal Send differs from Bulk 
Send in that it forces Group Mail to send individual messages to each Recipient. Also if 
you have embeded merge fields in the data then this is the only option available as you 
must send a unique message for each individual recipient. Please note that this option 
is slower than the Bulk option but the end result is often much more professional 
(because you have addressed each recipient individually).

If you choose the Bulk Send your message will be sent considerably quicker but the 'To' 
field of the message will contain the text string that you choose (default is the Group 
Name) and your 'Reply To' email address. Please note that Bulk Send Mode is not 
available in Group Mail Free - and that it cannot be used if you are sending 



personalized messages or using the Direct Send Email Setting.

Request Read Receipt:
If you set this option most email clients will send back a notice to you stating when your 
message was read by your recipients. Please note that not all email packages support 
this - and of those that do some give users the option of not sending the reply

Server & Identification Details:
If you wish to make any quick changes to either the server setup or the identification 
details (including custom ones) then you can do so here. Please note however that 
changes made here are not recorded and are just used for that one sending session.

Custom Attachments
Please click here for more details regarding Custom Attachments 

Filters:
Choose a Date Based Filter:
If you add recipients to your Groups on a regular basis then you can use these filters to 
do quick selective mailings e.g. you could send the same message to the group every 
week and have it only be sent to those recipients that were added since the start of the 
week.

Choose the Filters you wish to use:
You can enter any number of filters here which can be used to filter out recipients (to 
Ignore or Send to) based on any field in the Recipient record. For example if you were 
using Merge fields and you only wanted to send messages to Recipients that had a 
valid First Name then you could create a Filter which would IGNORE where 'First Name' 
Equals ''

Partial Sending:

If you need to step through the mailing of a group then you can use this option to select 
which part of the Group you would like to send mail to. It can also be a very fast way to 
recover from a failed mailing if you know the exact point of where the mailing ended.

Advanced Exclusion / Recovery:

If you have a temporary list of Recipients stored in a file that you do not wish to send the 
message to then you can enter the path of it here. This message could be a previous 
list of Recipients that received the message in an earlier attempt. Click here for 
information on how to obtain this list or click here for details on Restarting an incomplete 
mailing.
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Sending a Message

When Group mail is sending a message you can tell at all times what is going on. The 
screen below shows feedback from a typical send session.

Status: This shows what Group Mail is actually doing at that time.
Recipient Distribution Progress: This shows the progress of the complete job.

Message Delivery Progress: This shows the progress of the current message that is 
being sent out. If you're mailing in personal mode then this resets for each recipient. In 
bulk mode it resets after every split or reconnection.

Sent To: Shows the exact number of recipients that have received the message at that 
point in time.
Excluded: Shows the number of recipients who have been found to have entries on the 
Exclusion List or the Block file
Filtered: Show the number of recipients that have been excluded from the mailing by 
send filters that you setup while Preparing to Send the Message.
Errors: Shows the number of errors which have occurred so far. This includes errors 
generated by invalid recipients etc.
Time: Total Time take so far.

Session Details: This is a log of all the information that has been sent to and received 
from the Mail Server.

Please note that all this information is logged and can be retrieved at the end of the 



mailing.
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Error Messages & Logging

When you have finished sending your message the Send results window will appear.

The most important feature of this are the logs that are available. You can see exactly 
who received the message, what errors occured, which recipients were not mailed (and 
why - Errors, or because of Filters). 

Use the drop down list to select which log you would like to view. Also you should save 
any logs that you wish to keep. Use the Save As button to do this. Group Mail will reset 
these logs for each mailing.

The most important log is the Sent Log. If for some reason your connection got 
terminated or your PC got powered down before you completed the mailing (if this 
happen go to the Group Mail\Logs directory and retrieve the file there before restarting 
Group Mail, it will be called Sent.log) then you can use this file as a block file when you 
go to send the message again. This will help you avoid resending the same message 
over and over again to the same recipients. For more information on this please see 
here.

Return to the Main Index

Copyright © 2001 infacta ltd, All rights reserved - http://www.infacta.com



Restarting an incomplete mailing

If the worst should happen and you need to restart a mailing then you need to retrieve 
the log of the previously mailed recipients. To do this open Explorer and go to the Group 
Mail\logs directory. In this directory you will find a file called sent.log. Please note that 
this file only contains details of your last mailing. You should copy this to another 
location and then select it on the Advanced Exclusion / Recovery tab on the Prepare to 
Send Screen (See below).
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How to Purchase Group Mail Pro or Plus

Purchase Group Mail Pro now for $49.95 and receive .....

· The Bulk Sending Option (for faster sending) will be enabled,

· No Send Size limitations.

· Direct Send is enabled - no need for an SMTP Server.

· Free Product Updates and Fixes with Release Notification.

· Full Free Priority Expert technical support. 

Purchase Group Mail Plus now for $149.95 and receive .....

· Everything in Group Mail Pro - and then some.

· SMTP Express sending - increases the throughput of Group Mail Pro by at least 
a factor of 10. SMTP Express adds background sending, queuing, fire and forget 
delivery and much much more to Group Mail.

If you require further information on either of these versions please check out the 
http://www.infacta.com/purchase.html

Upgrade and multiuser pricing is available on request.

HOW TO ORDER

Using Credit Card
For your convenience, you may order by credit card in any of the following ways:

1. Online: 
You can order over the World Wide Web using a secured form. All information sent this 
way is encrypted for your protection. This is the fastest way to order.

To use our Secure Order page click here: http://www.infacta.com/purchase.html

2. Telephone: 
1-877-REGSOFT (1-877-734-7638)
International : +1-770-319-2718



When ordering by phone, please state either of these product IDs: 

Group Mail Pro: 34362

Group Mail Plus: 34604 

3. FAX: 

US Customers: 1-800-886-6030
International Customers: +1-208-279-3837
UK Customers: (0870) 132-2485

When ordering by FAX, please fill out and use this order form

4. Postal Mail:
RegSoft.com Inc.
PMB 201
10820 Abbotts Bridge Rd.
Suite 220
Duluth, GA 30097
USA

When ordering by mail or fax, please provide the information requested in this order 
form. 

By Check or Money Order:

You may also order by check or money order. Please fill out the following form and send 
it with your check or money order (in U.S. Dollars only) to:

RegSoft.com Inc.
PMB 201
10820 Abbotts Bridge Rd.
Suite 220
Duluth, GA 30097
USA

Made payable to RegSoft.com Inc.

Please make sure to include your email address in order for us to be able to fulfill 
the order.
All purchases are processed and fulfilled by RegSoft.com Inc. - http://www.regsoft.com
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Trouble Shooting & Technical Support

The fastest and most precise way to contact Technical Support is from within the 
Product. Click on the Help Menu and then click on the Technical Support item. This will 
startup a small utility which will allow you to the send the information we may require in 
order to be able to help you.

The infacta website contains information on the latest versions available and an FAQ 
which you should also check out.

If you would like to contact Technical Support by more conventional means then please 
send email to support@infacta.com. Please make sure to include your product serial 
number (if you have one), order number, a description of the problem and also a 
detailed description of your system. 

Email: support@infacta.com
Web: http://www.infacta.com

Please note that Group Mail Pro and Plus customers are treated with higher 
priority that those users using Group Mail Free and that we do not provide 
technical support via telephone at this time.

If you would like to contact infacta ltd. on another matter then please click here.
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Contacting infacta

· infacta ltd.
Ballyrankin,
Bunclody,
Co. Wexford,
Ireland

Voice: +353 54 75010 (Please note that this is not a technical support number)

Fax: +353 54 75010 (Please note that this is not a technical support number)

Web: http://www.infacta.com
Email: info@infacta.com

· Marketing and Sales
Jonathan Hill
hill@infacta.com

· Technical Information
Seamus Connolly
connolly@infacta.com

· Technical Support
See: Contacting Technical Support
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Product License and Disclaimer

END-USER LICENSE AGREEMENT FOR "Group Mail v3.X"

IMPORTANT - READ CAREFULLY Please read the following license agreement. You 
must agree to its terms before purchasing a license for Group Mail or downloading any 
version of Group Mail. 

This end-user license agreement ("EULA") is a legal agreement between you (either an 
individual or a single entity) and infacta ltd. for Group Mail v3.X, including computer 
software, electronic documentation and printed materials ("SOFTWARE"). By 
Downloading, installing, copying, or otherwise using the SOFTWARE, you agree to be 
bound by the terms of this agreement. If you do not agree to the terms of this EULA, 
promptly destroy all copies of the SOFTWARE, including any updates, in your 
possession or return them to infacta ltd. 

The SOFTWARE is protected by copyright laws and international copyright treaties, as 
well as other intellectual property laws and treaties. The SOFTWARE is licensed, not 
sold. 

1. GRANT OF LICENSE. infacta ltd. grants to you as an individual, a personal, 
nonexclusive license to make and use copies of the SOFTWARE in the manner 
provided below. If you are an entity, infacta ltd. grants you the right to designate one 
individual within your organization to have the right to use the SOFTWARE in the 
manner provided below. 

infacta ltd. may have patents or pending patent applications, trademarks, copyrights, or 
other intellectual property rights covering the SOFTWARE. You are not granted any 
license to these patents, trademarks, copyrights, or other intellectual property rights 
except as expressly provided herein. infacta ltd. reserves all rights not expressly 
granted. 

infacta Ltd. reserves the right to terminate this license at any time, at which time you 
must destroy all copies of the Software you have previously installed.

2. COPYRIGHT. All title and copyrights in and to the SOFTWARE (including, but not 
limited to, any images, photographs, animation, video, audio, music, text, and "applets," 
incorporated into the SOFTWARE), the accompanying printed materials, and any copies 
of the SOFTWARE, are owned by infacta ltd. and its suppliers. The SOFTWARE is 
protected by copyright laws and international treaty provisions. Therefore, you must 
treat the SOFTWARE like any other copyrighted material except that you may either (a) 
make one copy of the SOFTWARE solely for backup or archival purposes, or (b) install 
the SOFTWARE on a single computer provided you keep the original solely for backup 
or archival purposes. You may not copy the printed materials accompanying the 
SOFTWARE. 



3. DISCLAIMER OF WARRANTY 
NO WARRANTIES. The SOFTWARE PRODUCT is provided "as is" without warranty of 
any kind. To the maximum extent permitted by applicable law, infacta ltd. and its 
suppliers disclaim all warranties, either express or implied, including, but not limited to, 
implied warranties of merchantability and fitness for a particular purpose and any 
warranty against infringement, with regard to the SOFTWARE. This limited warranty 
gives you specific legal rights. You may have others that vary from state/jurisdiction to 
state/jurisdiction. 

4. CUSTOMER REMEDIES. infacta ltd.'s entire liability and your exclusive remedy shall 
not exceed the price paid for the SOFTWARE. 

5. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent 
permitted by applicable law, in no event shall infacta ltd. or its suppliers be liable for any 
damages whatsoever (including, without limitation, damages for loss of business profits, 
business interruption, loss of business information, or any other pecuniary loss) arising 
out of the use of or inability to use this infacta ltd. product, even if infacta ltd. has been 
advised of the possibility of such damages. Because some states/jurisdictions do not 
allow the exclusion or limitation of liability for consequential or incidental damages, the 
above limitation may not apply to you. 

6. DO NOT SEND UNSOLICITED EMAIL. Be aware that you are solely responsible for 
the messages you send.    In many cases, sending unsolicited email is in violation of the 
law, and you will be solely accountable and liable for damages and violations.
 
We reserve the right to refuse technical support and/or other services if you:
 
      1. send unsolicited email; or
      2. you hijack a mail server relay; or
      3. distribute illegal information or materials; or
      4. forge header information; or
      5. put false of misleading information in the subject; or
      6. fail to provide a means for unsubscribing from your lists

Should you have any questions concerning this Agreement, please contact infacta Ltd.
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Attaching Files

With Group Mail you can attach any number of files to a message. All files will be 
encoded as MIME Base 64 files where appropriate (This is the Industry Standard for 
Binary File Attachments). 

In order for your recipients to be able to view these files they must have a MIME 
compliant Email Client (the majority are). Otherwise they will need to avail of a MIME 
Decoder, of which there are a number of Freeware ones available.

It is recommended that you compress any files you send using a PKZip compatible tool 
before attaching them. This will make sending them a lot faster and your Recipients will 
be a lot happier to download smaller files.

On the Main Screen:

The attachment controls are positioned towards the bottom of the Edit Message Tab. 
They are also available from the Insert Menu.

To add attachments just click on the Plus button. To Remove attachments please select 
them from the Drop Down list and then click on the Minus button.

If you would like to send custom attachments for each recipient in your Group please 
click here for more information.

For information on how to send Inline encoded HTML files please click here.
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Preview: Main Screen
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Preview: Group Manager Tab
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Group Mail Order Form

Group Mail Pro - $49.95
Product ID: 34362
Program Name: Group Mail Pro
Operating System: Windows 9x / ME / NT / 2000

Group Mail Plus - $149.95
Product ID: 34604
Program Name: Group Mail Plus
Operating System: Windows 9x / ME / NT / 2000

Upgrade and multiuser pricing is available on request.

Please be sure your email address is correct! This is how you will receive your 
registration confirmation.

Which Product do you wish to order (Name or ID):

Billing Information 

Email Address:

Name (as it appears on credit card):
Company Name:(optional) 

Address (Exactly as it appears on your statement):
Address (cont): 
City: 
State/Province: 
Country: 
Postal Code: 

Phone Number: 
CC Type: 
Number: 

Card Expiration Date: 

Quantity:
This item is also available on CD-Rom for an additional $14.95. Tick below:
No, I do not wish to add the CD-Rom to my purchase
Yes, I wish to add 1 CD-Rom to my purchase
Yes, I wish to add 1 CD-Rom per QTY ordered to my purchase



Sign here to indicate that you agree with the above information and that you 
authorize RegSoft.com Inc. to bill your Credit Card for the amount stated as Total 
Price

{button Print,Print()}
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Group Mail Order Form (By Check)

Group Mail Pro - $49.95
Product ID: 34362
Program Name: Group Mail Pro
Operating System: Windows 9x / NT / 2000 / ME

Group Mail Plus - $149.95
Product ID: 34604
Program Name: Group Mail Plus
Operating System: Windows 9x / NT / 2000 / ME

Upgrade and multiuser pricing is available on request.

Please be sure your email address is correct! This is how you will receive your 
registration confirmation.

Which Product do you wish to order (Name or ID):

Billing Information 

Email Address:

Name:
Company Name:(optional) 

Address:
Address (cont): 
City: 
State/Province: 
Country: 
Postal Code: 

Phone Number: 

Quantity:
This item is also available on CD-Rom for an additional $14.95. Tick below:
No, I do not wish to add the CD-Rom to my purchase
Yes, I wish to add 1 CD-Rom to my purchase
Yes, I wish to add 1 CD-Rom per QTY ordered to my purchase

Please make checks payable to RegSoft.com Inc. Payment must be in the form of 
a Check or Money order payable in US Dollars.

{button Print,Print()}
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Custom File Attachments

With Group Mail you each recipient can have up to 4 unique files linked to them. These 
files can then be sent as custom attachments just for those recipients that have such 
files related to them.

To specify a custom attachment for a recipient you should enter the file name with the 
full path into any one of the additional fields (4) available (in that recipients listing in the 
Group). To do this manually just select the recipient from the Group Setup tab and click 
Modify - then double click in any of the additional fields (at the bottom of the Recipient 
Information window) and select the file that you wish to attach/specify as custom.

Please note that this information can also be imported when you are also importing 
recipients. Another important note is the fact that the file name (and path) can only be 
50 characters long at maximum. Custom file attachments are also disregarded if you 
select to send in Bulk Mode.

Each of the additional fields can be used for this purpose.

When you go to do your mailing you will see a Custom File Attachment tab on the 
Prepare to Send Screen. On this tab you can if you wish to include custom attachments. 
If you select to do so then you can choose which Additional Fields you wish to use. 

Custom file attachments can also be used in conjunction with regular attachments. 

It is recommended that you compress any files you send using a PKZip compatible tool 
before attaching them. This will make sending them a lot faster and your Recipients will 
be a lot happier to download smaller files.
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Glossary

D
DNS

S
SMTP



DNS
Domain Name Server - used to convert domain names to IP addresses or vice versa.



SMTP
SMTP - Email Server - bascially this is the server typically hosted by your Internet Service Provider that 
handles all of the email messages that you wish to send.






